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What’s New in Maptitude 2018 
 

Maptitude 2018: New Features Overview 
Maptitude 2018 is a major release of Caliper Corporation’s popular Geographic Information 
System (GIS) and mapping software. The 2018 version provides the most up-to-date and accurate 
data available. 

Maptitude 2018 provides the business value you expect when investing in mapping software. 
Maptitude includes the latest streets, postal data, and demographics. Maptitude 2018 is the 
fastest and most intuitive professional mapping application, with significant enhancements to 
usability, data import/linking, and information sharing. 

Key Features of Maptitude 2018: 
1. The most up-to-date geographic and demographic data available, including new fields for all 

layers, from ZIP Code to State, describing growth in income and population and daytime 
population counts 

2. The ability to link to external data and update your map layer without having to reimport 
your table from scratch 

3. An improved installer and downloader that support additional environments 
4. Support for waypoints from MapPoint and Streets & Trips (.PTM, .EST, .AXE) that further 

helps Maptitude to fill the void since the discontinuation of Microsoft MapPoint 
5. The geocoder successfully pin-maps even more address and postal data 
6. A new site selection wizard that helps you identify the best locations for servicing your 

customers or target market 
7. Drive-time zone reports that use the labels/names of your stores and customers 
8. An updated Create-a-Map WizardTM that allows you to add shaded boundaries to an 

existing map 
9. Support for travel time or distance between ZIP Codes, or any other area layer 
10. Better formatting for the one-click export to Excel reports and full turn-by-turn directions for 

the routing report 
11. 3-D themes that support the visualization of two fields rather than just one 

Maptitude can map your information whether you have data from Google Maps, from a Microsoft 
mapping product such as MapPoint, or from Microsoft Office. You can analyze your information 
using the intuitive Maptitude 2018 mapping wizards, and export your results as attractive 
preformatted Excel or PDF reports.  

Maptitude delivers easy-to-use professional mapping tools and data at the unbeatable price of 
only US$695 (or US$395 for upgrades.) For pricing and ordering information, please visit the 
Mapping Software Store, e-mail Maptitude Sales, or call US sales at +1 617-527-4700.  

http://www.caliper.com/maptpric.htm
https://www2.caliper.com/store/product-category/software/
mailto:sales@caliper.com
tel:+16175274700
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New Data 
Country Packages 
Maptitude 2018 comes standard with one detailed Country Package of your choice, and 
additional Packages can be purchased separately. Each Package includes a wealth of data 
unavailable in any other product, such as an up-to-date street layer with addresses for pin-
mapping (geocoding) and travel time information for computing routes and drive-time rings. 
Features such as building footprints for many urban locations, railways, and named landmarks are 
also built in to the software. The comprehensive landmarks range from public facilities to 
commercial buildings including businesses, restaurants, and retail stores. Where available, postal 
data and detailed demographics are shipped with the product. 

As you switch between the countries you have purchased, Maptitude will seamlessly refresh the 
interface with country-specific tools such as Create-A-Map Wizard and tools for finding, pin-
mapping, and routing. New Map Libraries allow you to easily create attractive geographic and 
demographic maps while locating unlimited numbers of addresses and territory-based records. 

The basic global map that is provided with every Maptitude license enables you to view your data 
for anywhere on Earth, and it allows you to map your locations by coordinate, manually, or by any 
populated place (village/town/city). 

United States 
New U.S. datasets provide access to the most 
up-to-date geographic information available. 
Maptitude 2018 comes with October 2017 
HERE® Map Content, which allows for 
accurate address locating and street 
visualization in addition to robust data with 
which you can calculate shortest paths, drive-
time rings, and drive-time territories (network 
partitions). Speeds based on HERE Traffic 
Patterns are now included. 

Other 2017 U.S. map layers from HERE 
include those for buildings, highways, 
railroads, and landmarks. The Points of 
Interest layer contains over two million 
named public and business locations. 

Maptitude 2018 ships with the January 2018 
ZIP Code update to ensure that you are using 
the latest data. The 5-digit ZIP Code 
boundaries are a nationwide area database 
with ZIP Codes for all 50 states, the District of 
Columbia, Puerto Rico, and the territories.  

 
Includes October 2017 map layers from HERE 

 
Includes daytime population data 
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Other standard features of Maptitude 2018 are updated 3-digit ZIP Code areas and a point 
database of ZIP Code centroids for the entire country. The ZIP Code area layers extend into non-
deliverable areas to provide complete coverage of the USA. The 3-digit and 5-digit ZIP Code 
areas include updated counts of businesses by detailed industry type (retail, finance, etc.), along 
with the number of employees working in each ZIP Code, and annual payroll figures. The ZIP 
Codes are also classified by their updated rural-urban commuting characteristics and with the 
numbers of hospitals, hospital beds, and healthcare providers.  

The US Census boundaries (e.g., Tracts, Counties, MCDs, MSAs, States) and the 3- and 5-digit ZIP 
code areas that come with Maptitude contain some or all of several demographic profiles from a 
variety of data providers. These sources include the 2010 Census and the 2016 American 
Community Survey (ACS) to name a few. This data is available for the USA, Puerto Rico, and the 
Territories. These layers now include daytime population, and percent change (2015 to 2016) in 
population, median income, and mean income. The ZIP Code, Tract, County, and State layers also 
include updated buying power (disposable income for 2015) figures. Tracts also list updated 
banking compliance FFIEC data for 2017. The Map Librarian makes it easy to access a series of 
pre-defined thematic and shaded maps of these updated data. 

The Country Package updates under development are listed below: 

Australia 
• October 2017 HERE update with speeds based on noontime HERE® Traffic Patterns 
• Updated HERE postal boundaries and centroids 
• 2016 Census Demographics 
• Updated 2017 Local Government boundaries with 2015 Population by age and gender 
• Updated 2017 Suburbs/Localities 
• Updated 2017 Wards 
• Updated Point Addresses 
• Updated 2016 Mesh Blocks 
• Updated 2017 Commonwealth Electoral Boundaries 
• 2016 State Parliament Electoral Boundaries (Lower/Upper houses) 

Brazil 
• October 2017 HERE update with speeds based on noontime HERE® Traffic Patterns 
• Updated HERE postal point layer 

Canada 
• October 2017 HERE update with speeds based on noontime HERE® Traffic Patterns 
• Updated 3-digit postal Forward Sortation Area (FSA) boundaries and centroids (HERE) 
• Updated 3-digit postal Forward Sortation Area (FSA) boundaries (Caliper) 
• Updated 6-digit postal point layer (HERE) 
• 2016 Census demographics 
• Updated 2016 Dissemination Areas 

http://www.caliper.com/Maptitude/International/unitedstates.htm
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United Kingdom 
• October 2017 HERE update with speeds based on noontime HERE® Traffic Patterns 
• Updated postal boundaries for the UK (HERE) 
• Updated postal boundaries and postcode points for GB (Caliper) 
• NUTS boundaries - NUTS1, NUTS2, NUTS3, for the UK and Ireland 
• Local Administrative Units (LAU) - Level 1, for the UK  
• 2016 Estimated population by age and gender, UK 

Mexico 
• October 2017 HERE update with speeds based on noontime HERE® Traffic Patterns 
• Updated HERE postal boundaries and centroids 

New Zealand 
• October 2017 HERE update with speeds based on noontime HERE® Traffic Patterns 
• Updated HERE postal boundaries and centroids 

Network Analysis and Routing 
Routing & Directions Manager 
The Routing & Directions Manager now: 

• Allows numeric stop names via formula fields 
• Uses Windows time and currency units (internationalization) 
• Saves your itinerary options when saving your route 
• Provides turn-by-turn direction instructions in the PDF report 

Drive-Time Rings Toolbox 
The Drive Time Rings Toolbox creates the most accurate drive-
distance travel analysis on the market with the following 
enhancements to the tool: 

• When using a point layer for the origins and 
creating separate rings, you can choose a field 
in the point layer for identifying the rings from 
the Ring Names from drop-down list 
o This allows you to create multiple travel 

rings around multiple locations and still be 
able to identify the location for each ring 

o It allows you to create drive-time zone 
reports using, for example, the 
labels/names of your stores and customers 

• When clicking Calculate Demographics, the 
drive-time rings report includes the footer text  
from your Edit > Preferences. 
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Distance and Travel Time Tables Tool 
Maptitude 2018 makes it easy to identify alternative service suppliers, backup field 
representatives, and closest locations. The distance and drive-time tool creates an Excel table that 
lists the costs of travel between any number of origins and destinations, allowing you to easily 
sort the data to identify the closest locations. 

 

The Distance and Travel Time Tables Tool now: 

• Supports all area layers such as ZIP Codes and Counties 
• Shows missing values for points that don't connect to any street  
• Reports both time and distance when calculating the shortest or fastest routes 

New Map Styles 
Maptitude 2018 gives you the greatest flexibility to date in setting the styles of map features, 
themes, and selection sets. 

Styles 
• The default color palette for line layer color themes can be chosen under Edit > Preferences 

Layers 
• The 2018 Country Package maps are used when mapping global locations, rather than a 

separate global map, ensuring consistency between your maps  

Themes 
• The 3-D Themes tool 

supports the visualization 
of two fields rather than 
just one, via choices for 
both color and height 
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Locating Data 
The geocoding tools use the updated street and postal data, rendering location matching results 
more accurate than in older versions of Maptitude.  

Country Package Specific Changes 

Australia, Canada, and Germany: 
• The geocoding tools provide faster geocoding 
• The geocoding tools provide better success rates when locating Canadian addresses by postal 

codes and town 

USA 
• The geocoding tools provide better success rates when locating addresses by city and state 

World 
• Create-a-Map Wizard supports country and world city/town/settlement geocoding  
• Create-a-Map Wizard supports geocoding by country name in addition to abbreviation 
• Create-a-Map Wizard supports world geocoding even when no Country Package is installed 
• The locate tools provide faster world city geocoding 
• The Tools > Locate > Locate by World City tool supports more flexible geocoding and has a 

redesigned interface 
• The World city geocoding supports state/province abbreviations for US, Canada, and Mexico 

Improved Create-a-Map Wizard 
Create-a-Map Wizard is now more robust and easier to use: 

• The wizard-driven interface now allows you to add shaded boundaries (color themes) to an 
existing map 

• Create-a-Map Wizard automatically creates reports when demographics are chosen 
• The requirement to choose or create an ID field when importing data has been removed  
• The software allows you to link to external data and to update your map layer without having 

to reimport the entire table from scratch 
• The choice of a categorical field for a Color Theme uses the default Color Theme palette 
• The maps have been updated with the latest geography 
• The maps draw faster with simplified world country and province layer boundaries 

Creating Selections and Formulas 
Condition building tools improvement(s): 

• When selecting, “Allow sets to overlap” is the default for area layers  
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Analysis Tools 
Completely new and innovative analytics were added to Maptitude 2018: 

• The new "Spatial Autocorrelation" tool uses Moran's I to measure how likely two neighboring 
areas are to have similar values for a specific column of data 

• The Density/Heat Layer tool produces a layer named “Density” by default 
• The new “Facility Location” tool helps users identify optimal site locations for warehouses, 

hospitals, retail stores, manufacturing facilities, etc.  using the travel time or distance between your 
clients and facilities 
o This type of analysis can increase the efficiency of your existing facilities or help to determine 

the optimal locations for new facilities 
• The database join tools set the dataview highlight to be the user join field 
• The columns added to the Excel reports for the Distance and Travel Time Tables tool, the right-

click "Export to Excel" on radius drawing items tool, and the Routing Manager “Export to Excel” 
tool all include the distance and time units (e.g., miles and minutes) 

• The Excel reports now include formatting to fit column widths to their contents, to bold the 
column headings, and to freeze the top row 

 
The facility location tool helps you identify optimal sites, from a set of candidate sites, that meet your needs 

Imagery Improvements 
Accessing, creating, and visualizing image layers is a core feature of Maptitude:  

• The sources for the imagery layers “USGS Aerial Imagery” and “USGS Topographic Maps” 
have been updated 
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New Documentation 
Maptitude continues to provide numerous ways to get you started with the software. There is a 
brand-new color PDF User Guide. New and revised tutorials are incorporated into the Help.  

In addition, there are a variety of comprehensive learning materials, including videos and live and 
pre-recorded training webinars, that are available on the Caliper Corporation website. The training 
videos now run in all browsers, with full navigation, as YouTube videos. 

Maptitude 2018 includes a Windows Microsoft Office style question mark icon on most windows. 
Clicking this will take you to the relevant section of the Help. You can also hover over any menu 
item and click F1 to access the updated Help. 

System and Interface 
Maptitude 2018 supports the latest Windows operating systems, file types, and common design 
elements. Maptitude 2018: 

• Has an improved installer that:  
o Has support for USB drive and relative path installs 
o Has an improved Download Manager 
o Has an improved Key Activation Wizard 

• Includes several new and redesigned menus, buttons, graphics, and toolbars that make tools 
more distinguishable, familiar, and accessible 

• Provides improved usability features:  
o Whenever a toolbox/toolbar opens for the first time after you have started Maptitude, the 

tool will display on the Maptitude monitor, ensuring that you don’t “lose” tools that you 
dragged to another monitor in a previous Maptitude session 

o Workspaces and maps are prioritized in the File > Open file format list, whereas 
dataviews, layouts, figures, and charts have been moved down the list 

o More Save As windows are pre-populated with a helpful/informative/descriptive file 
name 

• Has improved memory usage and performance 
• Allows the user to choose Make Working Layer on a hidden layer via a right click in the 

Display Manager 
• Opens the Layer Editing Toolbar when creating a new layer 
• Adds new layers that are drag-dropped into a workspace to a Country Package map or to the 

working map 

New File Import Support 
• MapPoint (.PTM, .EST, .AXE) route waypoints as a point layer 

https://www.caliper.com/maptitude/mapping-software-video-tutorials.htm
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Geographic Information System Developer’s Kit (GISDK) 
APIs 
The GISDK .NET APIs make it easy to add mapping functionality to any Windows desktop 
application written in C# or any other .NET programming language.   

Code examples are here: http://www.caliper.com/Maptitude/extending-maptitude-in-dot-net.htm    

There is an additional User Guide for the Routing and Directions API that has been updated for 
Maptitude 2018, and you can contact Caliper Sales if you would like a copy. One highlight of the 
API changes: 

• The Caliper Python Module lets you access Maptitude via a program written in Python, and 
now supports Python, version 3, as well as Python 2.7 

GISDK Functions 
Please see the “Listing of GISDK Functions” topic in the Online Help to view a full list of GISDK 
functions that were added, changed, or replaced in Maptitude 2018. One highlight of the GISDK 
changes: 

• The GISDK Immediate Execution window is now a toolbar, allowing you to keep the toolbar 
open as you interact with the Maptitude interface 

About Caliper  
Caliper Corporation develops state-of-the-art Geographic Information System (GIS) software. 
With a focus on usability, Maptitude is designed to be the most cost-effective 
professional mapping software product. Maptitude enables organizations to leverage their 
location-based data to improve decision making and planning while minimizing expenditure 
through competitively priced solutions. 

Caliper is a privately held corporation and is a leading developer of mapping, 
redistricting, transportation, and GIS software. 

http://www.caliper.com/Maptitude/extending-maptitude-in-dot-net.htm
mailto:sales@caliper.com?subject=Request%20for%20Routing%20and%20Directions%20Network%20API
http://www.mappingsoftware.com/
http://www.caliper.com/Maptitude/GIS_Software/Default.htm
http://www.caliper.com/Maptitude/mappingsoftware.htm
http://www.caliper.com/maptitude/MappingSoftware.htm
http://www.caliper.com/MapSoftware.htm
http://www.caliper.com/mtredist.htm
http://www.caliper.com/tcovu.htm
http://www.caliper.com/Maptitude/GIS_Software/Default.htm
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